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MOLECULAR MODELLING EXERCISES  
 
OPIOID  MOLECULAR MODELLING EXERCISES 
 
EXERCISE 24.4  CONFORMATIONS OF FENTANYL 
 
INTRODUCTION 
 
Fentanyl (Fig. 1) was discovered in the 1960s and is still one of the most widely used opioid 
drugs used in medicine today (section 24.6.3.4 in the textbook). It is particularly useful as 
part of the anaesthetic treatment given to patients during surgery. Compared to morphine, it 
is a much simpler and more flexible molecule, and it is less certain what the active 
conformation might be.  

 
 

 
 

 
 
 
 
 
 
 
 
 
Figure 1  Fentanyl. 
 
NMR and X-ray crystallographic studies suggest that the preferred conformation for fentanyl 
is where the 4-propananilido moiety is in an equatorial position relative to the piperidine 
ring, and that the piperidine ring is in a chair conformation. The crystal structure also 
indicates that the substituents at either end of the piperidine ring are extended. The amide 
group is planar and orientated at right angles to the mean plane of the piperidine ring, while 
the anilino aromatic ring is almost at right angles to the plane of the amide group.  
   
In this exercise, we will generate conformations of fentanyl and try to identify the most stable 
conformation to see whether it matches the conformation identified above. 
 
 
INSTRUCTIONS 
It is suggested that you attempt the following instructions yourself before following the more 
detailed Procedures that follow. You may find the file entitled Common Operations for 
ChemBio3D/Chem3D a useful guide on how to carry out various operations.  
 
PART A)  
*Open the ChemDraw file for fentanyl (available in the ChemDraw folder) into ChemBio3D or 
Chem3D. 
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* Identify the steric energies of the unminimised and minimized structures and identify 
structural differences between the two structures. 
*Calculate the number of rotatable bonds and identify where they are. 
 
PART B) 
*Manually create different conformations of fentanyl by rotating rotatable bonds.  
*Generate different conformations of fentanyl using the dihedral drive to rotate two adjacent 
rotatable bonds. 
*Generate different conformations using molecular dynamics. 
 
PART C)  
*Generate the conformation identified by nmr and X-ray crystallography and compare its 
steric energy with those generated in parts A and B. 
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PROCEDURES 
There are various approaches that you can use to tackle these molecular modelling exercises. 
The following procedures illustrate how you might tackle this particular exercise, but they are 
not meant to be prescriptive. Note also that the results obtained may vary depending on the 
computer and the version of ChemBio3D or Chem3D used. For example, the specific 
conformations obtained from energy minimisation may differ, as may quantitative results 
such as steric energies. 
 
 
PART A) Fentanyl 
 
1. Create a 3D-model of fentanyl from its ChemDraw file. 
*Open ChemBio3D or Chem3D. 
*From the File menu, choose Open, then select the ChemDraw file for fentanyl from the 
ChemDraw folder. Click Open (Fig. 2). 
 
 

 

 
Figure 2  Unminimised structure of fentanyl. 
 
2. Calculate the steric energy for the unminimised 3D-structure of fentanyl. 
*From the Calculations menu, choose MM2, then Compute Properties.  
*Select Pi Bond Orders and Steric Energy Summary, and click Run. The value appears in the 
bottom window. The value will vary depending on the conformation present. In this example, 
it is 122.8 kcal/mol.  
 
3. Identify sources of steric strain (bond lengths, bond angles, and close contacts) in the 
unminimised structure. 
*From the Structure menu, choose Measurements, then Generate All Bond Lengths.  
*From the Structure menu, choose Measurements then Generate All Bond Angles.  
*From the Structure menu, choose Measurements, then Generate All Close Contacts.  
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The measurements generated can be found in the Measurements table to the left of the main 
window. If this is not visible, open the View menu and select Measurement Table. You may 
have to expand the window to see the table properly. 
For the conformation obtained here, the table revealed one of the bond lengths to be 1.463 Å 
compared to an optimum length of 1.438 Å, a bond angle that was 120o compared to an 
optimum value of 114o, and a close contact of 1.247 Å between two hydrogen atoms (H45-
H32). The relevant measurements can be displayed in the main window by clicking the boxes 
to the left of each entry in the Measurements Table (Fig. 3). 
The serial numbers for relevant atoms can be displayed for that atom by selecting the atom, 
then right clicking the mouse to give a further menu. From that menu, the serial number of 
the selected atom(s) can be displayed. 
 

 
    
Figure 3 Examples of bond lengths, bond angles and close contacts resulting in steric strain 
for the unminimised structure. 
  
 
4. Clear all measurements and carry out an energy minimization.  
*Take a note of measurements identified in figure 3, as well as the serial numbers of the 
atoms involved.  
*From the Structure menu, choose Measurements, then choose Clear. 
Note: Energy minimisation produces a structure with a higher steric energy than expected 
(42.6 kcal/mol) if the measurements are still present in the Measurements Table. 
Measurements need to be cleared before minimisation is carried out.  

*Energy minimize the structure by clicking on the energy minimisation icon . There is a 
significant change in the conformation of the structure, especially with respect to the 
orientation of the rings (Fig. 4). Therefore, energy minimisation may take several seconds. 
Once energy minimization has been carried out, the steric energy is provided in the bottom 
window as 26.41 kcal/mol. Note the difference in steric energies between the minimized and 
unminimised structures. 
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Figure 4  Energy-minimised structure. 
 
5. Compare the measurements before and after minimization. 
*Remeasure the bond length and bond angle measured in section 3. 
*Remeasure the distance between the hydrogen atoms that were in close contact (H-32 and H-
45) 
*Display the measurements in the main window (Fig. 5B). 
The measurements show that the original bond length of 1.463 Å is only slightly altered to 
1.460 Å following minimisation. The change in bond angle is more significant reducing from 
120o to 117.7 o.  However, the most significant change is in the distance between the two 
hydrogen atoms (H-32 and H-45). Before minimisation, these atoms were separated by only 
1.247 Å. After minimisation, the atoms are 3.569 Å apart. The relative positions of the two 
atoms are emphasised in figure 6 where the two hydrogen atoms are coloured green.  
 

   
 
Figure 5  The minimized conformation with measurements. 
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Figure 6 Atoms involved in the measurements taken before and after minimization are 
recoloured.  
 
 
 
6. Identify the number of rotatable bonds 
*From the Calculations menu choose Compute Properties.  
*Expand Molecular Topology and select Num Rotatable Bonds. Click OK. 
The bottom window shows that there are 7 rotatable bonds present. These are indicated in 
figure 7. ChemBio3D/Chem3D has identified the bonds coloured blue and red as rotatable 
bonds. However, the amide bond coloured blue should not be counted as a fully rotatable 
bond since its partial double bond character hinders rotation. Fentanyl should really be 
considered to have 6 rotatable bonds. 
 
 

 
 
Figure 7  Rotatable bonds in fentanyl.
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PART B) Conformational analysis  
In Part A, an energy-minimised conformation of fentanyl was obtained. However, energy 
minimization creates the nearest stable structure to the starting structure, and so the 
conformation obtained is not necessarily the most stable conformation (the global minimum).  
In Part B, we will create other conformations to compare their steric energies.  We will use 
three different methods of creating conformations, so copy and paste the energy-minimised 
structure of fentanyl into three separate windows so that you can compare the methods. 
 
1) Manual modification 
You can manually modify a structure to create different conformations. Here, we will create a 
less extended conformation where both aromatic rings point in similar directions.  
*Select the bond highlighted in figure 8A. 

*Open the rotation dial by clicking the small triangle to the right of the rotation tool . 
*Click on the SW pointing arrow at the bottom right of the rotation dial. 
*Enter 90 into the text box (Fig. 8B). 
*Press the return key on the keyboard to produce the new conformation (Fig. 9A). 

*Energy minimize  the structure. 
The structure alters shape slightly, but the two aromatic rings remain pointing in similar 
directions (Fig. 9B). The steric energy of the new conformation is 25.7 kcal/mol, which is 
more stable than the original conformation. 
  
You can carry out further manual manipulations to create different conformations. 
 
 
 
 

                     
 
   A      B 
Figure 8  A) Selection of the bond to be rotated. B) The Rotation dial. 
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  A     B 
Figure 9  A) Conformation obtained after bond rotation. B) Conformation obtained after 
energy minimisation 
 
 
2) Automated rotation to produce conformations 
ChemBio3D/Chem3D can automatically produce conformations by rotating a single bond or 
by rotating two bonds that are linked together. Here, we will create a conformational map 
involving stepwise rotation of the two bonds identified in figure 10. 
 

N N

O  
 
Figure 10  Identification of the two bonds that will be rotated to generate conformations. 
 
*From the File menu, choose Preferences to open up a window. 
*Click on the tab entitled Dihedral Driver. 
*Use the slider bar to alter the Resolution to 5o, then click on OK. Setting the resolution at 5 o 
means that each rotation carried out to generate a Double Angle plot will be 10 o. 

*Choose the select tool . 
* With the shift key depressed, click on both of the bonds identified in figure 10 to select them 
(Fig. 11). 
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Figure 11  Selection of the bonds to be rotated. 
 
*From the Calculations menu, choose Dihedral Angle, then Double Angle Plot. One of the 
chosen bonds will now rotate a full 360o. Once this is complete, the second bond rotates 10 o 
before the first bond does another full rotation. This continues until the second bond has 
rotated a full 360o. Once the calculation is complete, a chart appears (Fig. 12A). The axes 
correspond to the two dihedral angles defined by the atoms highlighted in figure 13. The 
relevant atoms can be identified by hovering the mouse over each atom. This opens up a pop 
up window that reveals the serial number for each atom.  
In the resulting chart, black and white contouring is used as an indication of steric energy. 
White squares represent unstable conformations with high steric energies, and black squares 
represent stable conformations with low steric energies. Clicking within the chart identifies 
the conformation involved at each point, as well as the steric energy associated with that 
conformation.   
 

 
  A      B 
Figure 12 Dihedral Driver chart. A) Generated without minimisation  B) Generated with 
minimisation. 
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The x-axis dihedral angle    The y-axis dihedral angle  
C(8)-C(7)-N(3)-C(2)    N(3)-C(7)-C(8)-C(9) 
173.7o for initial structure   -169.9o for initial structure 
 
Figure 13  Structures identifying the atoms that define the dihedral angles used for the axes. 
 
The range of steric energies is very large (25.92-488.77 kcal/mol). This is because rotations 
can lead to conformations where atoms are too close together. The resulting high steric 
energies means that high energy conformations dominate the scale of the chart and it is 
difficult to distinguish between the steric energies of stable conformations. Therefore, it is 
worth recomputing the plot to include an element of localized energy minimization. This will 
move atoms apart that are too close together to relieve excess steric strain without affecting 
the dihedral angles of the conformation involved. 
* Place the mouse cursor in the window with the Dihedral Driver Chart and right click the 
mouse to open up a menu. 
*Click on Recompute with Minimization. The bonds are rotated again to make the new 
Chart. However, the process takes longer this time because of the energy minimization that 
has to be carried out. This is particularly noticeable for conformations with bad steric 
interactions. The resulting chart now has a smaller range of steric energies ranging from 
25.66 to 109.6 kcal/mol (Fig. 12B). 
There are 36x36 conformations in the chart and it would take a long time to go through each 
of these conformations. Therefore, we will simplify matters by rerunning the analysis such 
that bonds are rotated every 60o. 
*Position the mouse cursor in the window with the Dihedral Driver Chart. 
*Right click the mouse to open up a menu. 
*Click on Set Resolution and change the resolution to 30o. Note that each rotation carried out 
in a dihedral driver chart is twice the set resolution when a double-angle plot is being 
generated. 
A new Dihedral Driver Chart is produced with 36 conformations that have undergone a local 
energy minimization (Fig. 14A).  
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   A      B 
Figure 14 A)  Dihedral Driver Chart generated with a resolution of 30o (each bond is rotated 
in 60o steps). B) Square representing the most stable conformation 
 
 
*Hover the mouse over each square to identify the most stable conformation. A pop up 
window gives the steric energy and the dihedral angles. The most stable conformation in this 
particular experiment had a steric energy of 26.53 kcal/mol (fig. 14B) 
*Click on the square to generate the conformation in the main window. 
*Select the resulting conformation and copy it. 
*Open a new window and paste the conformation into the new window. 

*Energy minimize the structure . Note that a full energy minismisation is required since 
only a partial energy minimization is carried out on each conformation when the plot is 
generated 
The resulting structure has a steric energy of 25.7 kcal/mol which matches the steric energy 
of the conformation identified in part B (Fig. 9B). The conformation is also very similar with 
both aromatic rings orientated in the same direction (Fig. 15). 
 
 

 
Figure 15 Stable conformation identified from the Dihedral Driver Chart. 
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3) Generating conformations by molecular dynamics 
The manual and automated rotation of bonds are systematic approaches to generating 
different conformations. A more random approach is to run a molecular dynamics program, 
which essentially heats the molecule in silico such that it can cross energy barriers to form 
different conformations. If a more stable conformation is identified then the structure may 
remain in that conformation because of the higher energy barrier needed cross back to the 
original conformation. This will depend on the target temperature set for the molecular 
dynamics. 
*Go to the window containing the original energy-minimised structure of fentanyl. 
*From the Calculations menu, choose MM2, then Molecular Dynamics. A table will come up 
showing default entries that include a Target Temperature of 300 K.  
*Keep the default values and click on Run. You will see the molecule vibrating and adopting 
various conformations.  

* The molecular dynamics program can be stopped by clicking on the Stop icon  when a 
different conformation is spotted. The structure can then be energy minimized. 
In one trial run the same folded conformation obtained above was obtained with a steric 
energy of 25.7 kcal/mol.     
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PART C  Generating the conformation identified by X-ray crystallography 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
Figure 16  Conformation of fentanyl identified by nmr and X-ray crystallography. 
 
None of the conformations generated in parts A and B match the conformation that was 
identified by nmr and X-ray crystallography (Fig. 16). Therefore, we will create this 
conformation by manually rotating bonds. 
* Copy and paste the original energy-minimised conformation from Part A into a new window 
(Fig. 17A). 
*Modify the conformation by manually rotating the bond shown in figure 17B by 90o. to 
generate the conformation shown in figure 18A. This rotates the aromatic ring in the ‘head 
group’ such that it is orthogonal to the plane of the carbonyl group.  
*Select the bond highlighted in figure 18B.  

   
   A       B 
Figure 17 
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   A       B 
Figure 18 Modifications of the conformation. 
 
*Rotate the bond by 180o to give the conformation shown in figure 19A.  
*Select the bond highlighted in figure 19B.  
*Rotate the bond by -60 degrees to give the conformation shown in figure 20. This now 
resembles the conformation identified by nmr and X-ray crystallography.  
 
 
 

   
   A       B 
Figure 19 Further modifications of the conformation. 
 

 
   A       B 
Figure 20 Unminimised conformation resembling the conformation identified by nmr and X-
ray conformation. 
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*Energy minimize the conformation . The resulting conformation (Fig. 21) has a steric 
energy of 32. 5 kcal/mol, which is higher than the original energy minimized conformation 
identified in part A.  
 

 
Figure 21 Energy-minimized conformation generated from the conformation shown in figure 
20. 
 
It is possible that another conformation exists that resembles the one shown in figure 21, but 
has a lower steric energy. To test this we shall try a molecular dynamics calculation. 
*Carry out a molecular dynamics operation at 300 K as described in Part B. 
In the trial run, the molecular dynamics operation generated a similar conformation (Fig.22) 
to the original energy-minimised conformation obtained in Part A   The steric energy was 
27.6 kcal/mol 
 

 
 
Figure 22 A conformation generated by molecular dynamics from the conformation shown in 
figure 21. 
 
To conclude, the most stable conformations generated by Chem3D/ChemBio3D differ from 
the one identified by nmr and X-ray crystallography. However, it is important to appreciate 
that the calculations carried out using Chem3D/ChemBio3D are on an isolated molecule. 
Studies carried out using nmr and X-ray crystallography are more realistic. For example, the 
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molecule can interact with surrounding solvent in nmr studies. In X-ray crystallography, a 
molecule of fentanyl can interact with solvent and other molecules of fentanyl within the 
crystal. Further in silico studies on fentanyl could be carried out where the molecule is 
surrounded by solvent molecules to see how that affects the relative stability of different 
conformations. 
 
 
 
 


